
 
 
 

 
 
 
 

INTRO TO WORD 2007 
 

Department of Technology Enhanced Learning 
Information Technology Systems Division 

 
 
 

Overview................................................................. 2 

Creating a New Document ..................................... 3 

Five Document Views............................................. 5 

Show and Hide Window Tools ............................... 6 

Zooming.................................................................. 6 

Page Views............................................................. 7 

Window Groups ...................................................... 7 

Saving Documents ................................................. 8 

Paper Size and Layout ......................................... 10 

Document Margins ............................................... 11 

Headers and Footers............................................ 12 

Multiple Columns .................................................. 16 

Formatting Characters.......................................... 17 

Formatting Paragraphs......................................... 18 

Bullets and Numbered Lists.................................. 20 

Format Painter...................................................... 22 

Spell Checking...................................................... 23 

Grammar Checking .............................................. 25 

Print Preview ........................................................ 26 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

TOPICS COVERED 
 
 

For assistance contact the 
Technology Assistance Center: 

962-4357 
E-mail: tac@uncw.edu 

 
Updated 8/07 

 



INTRO TO WORD 2007  
 

Intro to Word 2007                                                                                                                                        Department of Technology Enhanced Learning 
Last Modified: 8/07                                                                                                                                  Information Technology Systems Division, UNCW 

2

Overview 

Microsoft Word has grown considerably in power, sophistication and capability over the 
past decade, but one thing that hasn't changed since the early '90s is its user interface. 
The simple toolbar in version 2.0 has been packed with so many features since then 
that few users know where to find them all. Consequently, more and more people are 
looking for "insider" tips that will allow them to use these advanced and often hidden 
features. Microsoft has addressed this problem in Word 2007 by radically redesigning 
the user interface with a tabbed toolbar that makes every feature easy to locate and 
use.  

Word 2003 Word 2007 

 
 

 
Word 2003 Toolbar 

 
 
Word 2007 “Ribbon” 
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Creating a New Document 

When you start Word without opening an existing document, the program gives you an 
empty one to work in. If you're eager to put words to page, then type away. Sooner or 
later, though, you'll want to start another new document. Word gives you three ways to 
do so: 

• Creating a new blank document. When you're preparing a simple blank page 
this is fine. Or, when you're just brainstorming and you're not sure what you want 
the final document to look like, you probably want to start with a blank slate or 
use one of Word's templates to provide structure for your text. 
 

• Creating a document from an existing document. For letters, resumes, and 
other documents that require more formatting, why reinvent the wheel? You can 
save time by using an existing document as a starting point. When you have a 
letter format that you like, you can use it over and over by editing the contents. 
 

• Creating a document from a template. Use a template when you need a 
professional design for a complex document, like a newsletter, a contract, or 
meeting minutes. Templates are a lot like forms; the margins, formatting, and 
graphics are already in place. All you do is fill in your text. 

 

 

To start your document in any of the 
above ways, click the Windows logo in 
the upper-left corner of the screen. That's 
Office 2007's new Office button. Click it, 
and a drop-down menu opens, revealing 
commands for creating, opening, and 
saving documents, as well as printing. 
Next to these commands, you see a list 
of your Word documents. This list 
includes documents that are open, as 
well as those that you've recently opened. 
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Creating a New Blank Document 

Say you want a new blank document, just like the one Word shows you when you start 
the program. Here are the steps: 

1. Click the Office button, then New. 
 

2. In the upper-left corner of the large "Create a new Word document" panel, click 
Blank document. 
 

3. At the bottom of the New Document dialog box, click Create. 
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Five Document Views 

Word gives you five basic document views. To select a view, go to the View tab and 
choose one of the Document Views on the left side of the ribbon.  

 

You have another great option for switching from one view to another that's always 
available in the lower-right corner of Word's window. Click one of the five small buttons 
to the left of the slider to jump between Print Layout, Full Screen Reading, Web Layout, 
Outline, and Draft views. 

 

• Print Layout. The most frequently used view in Word, Print Layout, is the one 
you see when you first start the program or create a new blank document. In this 
view, the page you see on your computer screen looks much as it does when 
you print it – meaning you can see the entire page as well as the edges. 
 

• Full Screen Reading. If you'd like to get rid of the clutter of menus, ribbons, and 
all the rest of the word-processing gadgetry, then use Full Screen Reading view. 
As the name implies, this view's designed primarily for reading documents.  
 

• Web Layout. This view shows your document as if it were a single Web page 
loaded in a browser. You don't see any page breaks in this view. Along with your 
text, you will see any photos or videos that you've placed in the document just 
like a Web page 
 

• Outline. For lots of writers, an outline is the first step in creating a manuscript. 
Once they've created a framework of chapters and headings, they dive in and fill 
out the document with text. If you like to work this way, then you'll love Outline 
view.  
 

• Draft. Here's the no-nonsense, roll-up-your-sleeves view of your work. You see 
most formatting as it appears on the printed page, except for headers and 
footers. Page breaks are indicated by a thin dotted line. In this view, it's as if your 
document is on one single roll of paper that scrolls through your computer 
screen. This view's a good choice for longer documents and those moments 
when you want to focus on the words without being distracted by page breaks 
and other formatting niceties. 
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Show and Hide Window Tools 

Word gives you some visual aids that make it easier to work with your documents. Tools 
like rulers and gridlines don't show up when you print your document, but they help you 
line up the elements on the page. Use the ruler to set page margins and to create tabs 
for your documents. Checkboxes on the View tab let you show or hide tools, but some 
tools aren't available in all the views, so they're grayed out. You can't, for example, 
display page rulers in Outline or Full Screen Reading views. 

Use the checkboxes in the Show/Hide group of the View tab to turn these tools on and 
off: 

• Ruler. Use the ruler to adjust margins, set tabs, and position items on your page.  
 

• Gridlines. When you click the Gridlines box, it looks like you created your 
document on a piece of graph paper. This effect isn't too helpful for an all-text 
document, but it sure comes in handy if you're trying to line up photos on a page. 

 

 

Zooming Your View In and Out 

When you're working, do you ever find that you 
sometimes hold pages at arm's length to get a 
complete view, and then, at other times, you stick your 
nose close to the page to examine the details? Word's 
Zoom options let you do the same thing with your 
screen. 

On the View tab, click the big magnifying glass to 
open the Zoom dialog box.  Depending on your 
current Document View, you can adjust your view 
by percentage or relative to the page and text. The 
options change slightly depending on which 
Document View you're using. Also, the Page 
options don't really apply to Web layouts, so they're 
grayed out and inactive if you're in the Web Layout 
view. 
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Changing page view from the ribbon 

The ribbon offers radio buttons for three popular page views. They're a quick way to 
change the number of pages you see onscreen without fiddling with zoom controls. 

• One Page. This view shows the entire page in Word's document window. If your 
screen is large enough, you can read and edit text in this view. 
 

• Two Pages. In this view, you see two pages side by side. This view's handy 
when you're working with documents that have two-page spreads, like booklets. 
 

• Page Width. This button does the exact same thing as the Page Width button in 
the Zoom dialog box. It's more readable than the One Page and Two Page 
options, because the page fills the screen from edge to edge, making the text 
appear larger. 

 

The Window Group: Doing the Splits 

In previous versions of Word you could work on only one document at a time. Although 
Word 2007 has more options for viewing multiple documents and multiple windows than 
ever, some folks forget to use them-Big mistake. If you ever find yourself comparing two 
documents or borrowing extensively from some other text, then having two or more 
documents visible on your screen can double or triple your work speed. 

The commands for managing multiple documents, views, and windows are in the View 
tab's Window group. 

 

 

 

 

• New Window. When you're working on a long document, sometimes you want to 
see two different parts of the document at the same time, as if they were two 
separate documents. You may want to keep referring to what you said in the 
Introduction while you're working in Chapter 5. That's where the New Window 
command comes in. When you click this button, you've got your document open 
in two windows that you can scroll independently. Make a change to one window, 
and it immediately appears in the other. 
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• Arrange All. Now you've got documents open in two or more windows, but it 
takes a heck of a lot of mousing around and window resizing to get them lined up 
on your screen at the same time. Click Arrange All and your open Word 
document windows are sharing the screen, making it easy to work on one and 
then the other.  
 

• Split. The Split button divides a single window so you can see two different parts 
of the same document.  This is particularly handy if you're copying text from one 
part of a document to another. The other advantage of the Split command is that 
it gives you more room to work than using Arrange All for multiple windows 
because it doesn't duplicate the ribbon, ruler, and other Word tools. 

 

2 Windows after having clicked Arrange All 2 Windows after having clicked Split 

  

 
 

Saving Documents 

With the release of Microsoft Office 2007, the usual “.doc” extension is no longer the 
default file type when saving your Word documents.  The new extension is “.docx”.   

This change has allowed Microsoft to incorporate the many new and exciting features 
that Word 2007 has to offer.  It can however be somewhat confusing if you are unused 
to seeing your Word documents saved as such.  Below we outline how to save your 
Word 2007 documents so that they are 100% compatible with previous versions of 
Word. 
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Saving by keyboard shortcut 

• Ctrl+S. If you're an old hand at Word, this keyboard shortcut may already be 
burned in your brain. It still works with Word 2007 and other Office 2007 
programs. This command quickly saves the document and lets you get back to 
work. 
 

• Alt+F, S. This keyboard shortcut does the exact same thing as Ctrl+S. Unlike 
Ctrl+S, though, you get visual reminders of which keys to press when you press 
the Alt key. 

 

Saving by menu command 

• Office button  Save. If you don't want to 
use keyboard shortcuts, you can mouse 
your way to the same place using menus. 
Like the options above, this command 
saves your file with its current name. 
 

• Office button  Save As. The Save As 
option lets you save your file with a new 
name.  When you use this command, you 
create a new document with a new name 
that includes any changes you've made. 

NOTE: When you choose “Save As”, you are 
given the option of what type of file to save 
your document as.  In order to ensure 
maximum compatibility, choose “Word 97-
2003 Document”. 
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Choosing Paper Size and Layout 

When you edit a document in Word, what you see on your computer screen looks 
almost exactly like the final printed page. To get that correct preview, Word needs to 
know some details about the paper you're using, like the page size and orientation. You 
have two different ways to change the page settings: using the Page Layout tab  or the 
Page Setup dialog box. When you click the Page Layout tab, the ribbon's buttons and 
icons change to show you options related to designing your page as a whole. Your 
options are organized in five groups: Themes, Page Setup, Page Background, 
Paragraph, and Arrange. 

Changing Paper Size 

If you want to quickly change the page size to a standard paper 
size like letter, legal, or tabloid, the Page Layout Page Setup Size 
menu is the way to go. With one quick click, you change your 
document's size. If there's text in your document, Word reshapes 
it to fit the page. Say you change a 10-page document from letter 
size to the longer legal-size page. Word spreads out your text 
over the extra space, and you'll have fewer page overall. 

The Size menu, like many Word 2007 menus, uses icons as well 
as text to give you quick visual cues. Your choices include Letter 
(8.5" x 11"), Tabloid (11" x 17"), and more. If you're using 
standard-size paper (including standard international sizes like 
A3 and A4), you can click one of these choices, and you're done.  
 
If you're using an odd size paper, see the steps on the following 
pages. 
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Setting Paper Orientation 

Most business documents, school papers, and letters use a portrait page 
orientation, meaning the page is taller than it is wide. But sometimes you 
want a short, wider page orientation to accommodate a table, chart, or 
photo.  This is called landscape orientation. Whatever the reason, using 
the Orientation menu (Page Layout Page Setup Orientation) is the easiest 
way to make the change. Just click one of the two options: Portrait or 
Landscape. 

If you've already got the Page Setup box open, you'll find the Orientation 
options on the Margins tab (Page Layout  Page Setup  Margins  
Custom Margins). 

 

Setting Document Margins 

Page margins are more than just empty space. The right 
page margins make your document more readable. 
Generous page margins make text look inviting and give 
reviewers room for notes and comments. With narrower 
margins, you can squeeze more words on the page; 
however, having too many words per line makes your 
document difficult to read. With really long lines it's a 
challenge for readers to track from the end of one line back 
to the beginning of the next. Margins become even more 
important for complex documents, such as books or 
magazines with facing pages. With Word's margins and page 
setup tools, you can tackle a whole range of projects. 

 
Selecting Preset Margins 
 
Word's Margins menu (Page Layout  Page Setup  
Margins) gives you a way to quickly apply standard margins 
to your pages. The preset margins are a mixed bag of 
settings from a half inch to one and a quarter inches. For 
most documents, you can choose one of these preset 
margins and never look back. 

The Margins menu provides some standard settings such as 
the ever popular one inch all the way around. Word calls this 
favorite of businesses and schools the Normal margin. If 
you've customized your margins, your most recent settings 
appear at the top of the menu. 
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For each of the preset margin options you see dimensions and an icon that hints at the 
look of the page. 

• Normal gives you one inch on all sides of the page. 

• Narrow margins work well with multicolumn documents, giving you a little more 
room for each column. 

• Moderate margins with three-quarter inches left and right let you squeeze a few 
more words in each line. 

• Wide gives you more room for marginal notes when you're proofing a 
manuscript. 

To select one of the preset margins, go to Page Layout  Page Setup  Margins, and 
then click one of the options.  
 
 

Adding Headers and Footers 

Headers and footers are where Word puts the bits of information that appear at the top 
or bottom of every page of most multipage documents.  They remind you of the page 
number, chapter title, and so on, as you read along.  

 
Introducing the Header and Footer Tools 

Unlike some of the other features in this section, the header and 
footer tools are on the Insert tab (not the Page Layout tab). As you 
can see, three menus appear in the Header & Footer group - 
Header, Footer, and Page Number. Each of the menus provides 
predesigned page elements, known in Word-speak as Building 
Blocks. So, for example, if you select a header Building Block, it 
may add text and several graphic elements to the top of your page. 
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Inserting and Modifying a Header Building Block 

Go to Insert  Header & Footer  Header, and you see 
more than a dozen predesigned header options. You can 
keep these canned headers as they are, or use them as 
a starting point for your own imagination. The following 
steps show you how to use a Building Block to add a 
header to your document and then tweak it a bit by 
inserting an additional field. 

 

1. Go to Insert  Header & Footer  Header to 
open the Header menu. 

If you've used earlier versions of the program, 
you'll notice that the drop-down menus in Word 
2007 are larger and much more visual. The 
Header menu is a good example, as it gives you a 
clear representation of the available predesigned 
headers. 

2. Use the scroll bar on the right to find the Tiles 
header. 

You can drag the box in the scroll bar to move 
quickly through the menu, or use the arrow 
buttons to browse through the examples. 

3. Click the Tiles header to insert it into your document. 

When you select the Tiles header, you're adding more than text to your 
document: A Building Block comes with all its own accessories. The Tiles header 
includes a box with a rule around it and two tiles of color. Inside the tiles are 
bracketed words. 

When you insert a header, a couple of other things happen too. The Header 
menu closes and a new Design tab appears on your ribbon, with a Header & 
Footer Tools tab above. Along with that, a whole slew of new buttons and tools 
appear on the ribbon (left to right): Header & Footer, Insert, Navigation, Options, 
Position, and the Close Header and Footer button. 
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4. Click the bracketed words "Type the document title," and then type a title of your 
choice. 

The bracketed words are a prompt that you're supposed to enter new text in that 
spot. A single click anywhere on the words selects the entire group. Type your 
title, say, “Class Sample”. When you type, the other words and the brackets 
disappear. When you add a title to the header, Word uses this text to update the 
title shown in the Document Properties (Office button  Prepare  Properties). 

5. Click the bracketed word "Year," and then use the calendar control to update the 
header's Year field. 

This standard Word tool lets you enter a date by selecting it. At the top, you see 
the month and year. Click the buttons on either side to move backward or 
forward through the months. Click a date on the calendar below to select a 
specific date. Word uses the year from the date you selected to update the Year 
text in the header. Or you can enter a year simply by typing it. 

6. Click the header to the right of your title. If the title is highlighted, use the right 
arrow key to deselect the title, and then type a hyphen (-) followed by a space. 

You can also add automatically updating text by inserting a field, which is how 
Word creates those ever-changing dates and page numbers. Word has fields for 
lots of other stuff too. You can't create (or edit) a field by typing directly in your 
document, though. You must use the Field dialog box. 

7. Choose Insert  Quick Parts  Field. 

The Field dialog box opens showing an alphabetical list of field names on the left 
side, as shown in Figure 3-14. Fields store information about your document and 
keep track of other information that you can use in your documents. 

Using fields, you can add 
automatically updating page 
numbers, dates, and 
names. The Field dialog box 
shows a whole list of fields 
(left) and provides ways to 
format them (right) so that 
they work just right. 
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8. Double-click the Author field name to insert it into the header. 

The author's name appears next to the title in the header. (If you're working on 
your own computer, it's probably your name.) This text is grayed out to show that 
it's a field and that you can't edit it directly. 

9. Double-click anywhere on the document's body text to close the Header & Footer 
Tools contextual tab. 

You have two options for closing the header and going back to editing your 
document. You can double-click anywhere outside the header, or, on the right 
side of the ribbon, you can click the Close Header and Footer button. Either way, 
the header fades out and the text of your document sharpens up. Your insertion 
point appears back in the body text, and you're ready to work. 

 

Adding a Matching Footer Building Block 

Most of the header Building Blocks have 
complementary footers. For example, the Tiles 
header used in the step-by-step example provides 
title and date information, while the Tiles footer 
provides company and page information. The steps 
for inserting the Tiles footer are nearly identical to the 
header steps. Just start with the Footer menu: 
Choose Insert  Header & Footer  Footer. 

 

Most of the header and footer Building Blocks come in 
pairs. By using a header and footer with the same 
name, you can be sure of having a consistent design. 
You can modify Building Blocks like this predesigned 
header and footer after you insert them in your text. 
Just edit as you would any text. It's best to leave the 
page numbers as they are, though. This page number 
is grayed out to indicate that it's a field that 
automatically changes for each page. 
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Working with Multiple Columns 

Word makes it easy to work with multiple newspaper-style columns. Instead of your 
having to use tabs or spaces to separate the column one line at a time, Word lets you 
set up the column guidelines and then type away. When you type text in a multicolumn 
layout, your words appear in the left column first. After you reach the end or bottom of 
the column, the insertion point jumps to the top of the next column and you begin to fill 
it, from top to bottom. 

To use multiple columns, go to Page Layout  Page Setup  Columns, and then click 
one of the following options: 

• One. Whether you know it or not, every page in Word has a column layout. The 
standard layout is one big column stretching from margin to margin. 
 

• Two. With two columns, your document begins to look like a pamphlet or a 
school textbook. 
 

• Three. Three columns are about as much as a standard 8.5 x 11-inch page can 
handle, unless you switch to Landscape orientation. In fact, you may want to 
reduce the body text size to about 9 or 10 points and turn on hyphenation. 
Otherwise, you can't fit very many words on a line. 
 

• Left. This layout has two columns, with the narrower column on the left. The 
narrow column is a great place to introduce the text with a long heading and 
subheading or a quote pulled from the larger body text. 
 

• Right. The mirror image of the Left layout, this option uses two columns with a 
narrow column at right. 
 

• More Columns. Use the More Columns option to open the Columns 
dialog box where you can create a customized column layout. 

At the top of the Columns dialog box, you see the same presets as on the 
Columns menu. Below them, controls let you create your own multicolumn 
layouts. The preview icon on the right changes as you adjust the settings. 

When you get to the bottom of a column, Word automatically flows your 
text to the top of the next one, but you can also force Word to end the 
column and jump to the next one. There are two ways to create a column 
break. The quickest way while you're typing is to use the keyboard shortcut 
Ctrl+Shift+Enter. Or, if you forget the shortcut, you can use the ribbon: 
Page Layout  Page Setup  Breaks  Column. 
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Formatting Characters 

Every character in your document is formatted. The formatting describes the typeface, 
the size of the character, the color, and whether or not the character is underlined, bold, 
or capitalized. It's easy to change the formatting, and Word gives you quite a few 
different ways to do it. The easiest and most visual way is with the ribbon (Home  
Font). 

For quick formatting, you may not need to go any further than the mini-toolbar that pops 
up when you select text for formatting.  Whichever method you use, formatting is a two-
step process. First, tell Word which text you want to format by selecting it. Then format 
away. Or, you can set up your formatting options first, and then begin to type. Your 
letters and words will be beautifully formatted from the get-go. 

 

Formatting with the Ribbon or the Font Dialog Box 

Since character formatting is one of the most often used Word features, Microsoft put 
the most popular settings right on the Home tab. If you don't see what you're looking for 
there, then you must open the Font dialog box. The good thing about the dialog box is 
that it puts all your character formatting options in one place so you can quickly make 
multiple changes. 

Here are the steps: 

1. Select a group of characters. 
 

2. Go to Home  Font or the Font dialog box (click the little launcher button shown 
below) and make your formatting choices. 

Open the Font dialog box to change the typeface, style, size, color, and other 
effects. Like many dialog boxes, the Font box gives you access to more 
commands than you find on the ribbon. 
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Formatting Paragraphs 

Formatting a paragraph usually entails changing its shape. You may be squeezing it in 
with indents or stretching it out with additional line spacing. Other kinds of formatting 
change a paragraph's very nature, like adding a border or making it part of a numbered 
or bulleted list. The Paragraph formatting group (Home  Paragraph) is right next to the 
Font group. You don't need to select text to format a paragraph; just make sure the 
insertion point is in the paragraph you want to format. However, if you want to format 
several paragraphs at once, select them all before you apply a command. 

 

 

  
Paragraph formatting commands are in the Home  Paragraph group. Left to right, 
from the top, you find buttons to add bullets, numbers, apply indents, sort paragraphs, 
show the paragraph mark, align paragraphs, adjust line spacing, change the 
background color, and add borders. 

Aligning Text 

It's easy to apply alignment to text. With your insertion point in the paragraph you want 
to change, click one of the alignment buttons in the Paragraph group on the Home Tab. 
For example, Home  Paragraph  Left sets the current paragraph's alignment 

• Left. Aligns the lines in the paragraph flush on the left side and ragged on the 
right. Left alignment is standard for letters, reports, and many business 
documents. 

• Centered. Centers each line in the paragraph, leaving both left and right margins 
ragged. This setting is appropriate for headings and short chunks of text, as in 
invitations and advertisements. Avoid using centered text for long paragraphs, 
since it's hard for readers' eyes to track from the end of one line to the beginning 
of the next when the left margin is uneven. 

• Right. Aligns the lines in the paragraph flush on the right side and ragged on the 
left. This unusual alignment is most often used for setting captions or quotations 
apart from the main text. 

• Justified. Adds space between letters and words so that both the left and right 
sides of the paragraph are straight and flush with the margins. Justified margins 
give text a more formal look suitable for textbooks or scholarly documents. If your 
justified text looks odd because big gaps appear between the letters or words, try 
using a long line that is, putting more characters per line. You can do this by 
extending the margins (Alt+P, M) or by changing the size of your font (Alt+H, FS). 

Set the alignment of your paragraphs using the buttons on the ribbon. Four settings are 
available: Left, Centered, Right, and Justified. 
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Spacing between Paragraphs 

For documents like business letters or reports that use 
block-style paragraphs, there's usually a little space 
between each. You can adjust this spacing between 
paragraphs to set off some blocks of text from the rest. 

Use the Paragraph dialog box to adjust the distance 
between paragraphs. On the left, you can enter 
numbers to set the space before the paragraph and 
the space after. With body text paragraphs, it's good to 
set the same, relatively small distance before and 
after, generally three points. For headers, you may 
want to put a little extra space before the header to 
distance it from the preceding text. That space makes 
it clear that the header is related to the text beneath it. 
Generally speaking, the more significant the header, 
the larger the type and the greater the spacing around 
it. 

 

 

Spacing between Lines 

In the Paragraph box, to the right of the paragraph spacing controls, you find the "Line 
spacing" tools. Use these controls to set the distance between lines within paragraphs. 
You have three presets and three custom settings: 

• Single keeps the lines close together, with a minimum amount of space 
between. Single spacing is usually easy to read, and it sure saves paper. 

• 1.5 lines gives your text a little more breathing room, and still offers a nice 
professional look. 

• Double is the option preferred by teachers and editors, so there's plenty of room 
for their comments. 

• At least is a good option if you have a mix of font sizes or include inline graphics 
with your text. This option ensures that everything fits. 

• Exactly puts you in control. Type a number in the At box, and Word won't mess 
with that setting. 

• Multiple is the oddball of the bunch. Think of Multiple as a percentage of a single 
line space: 1=100 percent; .8=80 percent; 1.2=120 percent; and so on. 
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Creating Bulleted and Numbered Lists 

Bullets add impact and help organize information. Numbered paragraphs send a 
different signal, implying that the items listed are sequential or have a hierarchy. 
Meeting minutes are usually numbered, both as a point of reference and to indicate the 
order of the meeting's events. 

Like the other paragraph formatting options, you don't have to select a paragraph to 
format it. It's enough just to have the insertion point in the paragraph. When using 
bullets or numbers, you usually want to format more than one paragraph. To do that, 
make a selection, and then click the bullet or number button. 

Bulleted paragraphs 

It's easy to turn an ordinary paragraph into a bulleted paragraph Word does all the 
heavy lifting for you. You may spend more time choosing a bullet style than applying it. 

Here's how to create a bulleted list: 

1. Go to Home  Paragraph, and then click 
the triangle next to the Bullet button to open 
the Bullets menu. 

At the top of the menu you see bullet styles 
that you used recently. In the middle, you 
see your Bullet Library. The bottom section 
shows bullet styles that have already been 
used in the document. At the very bottom 
are two commands for customizing bullets. 

The Bullet menu provides choices from the 
traditional filled circle to more contemporary 
options. If you have your own ideas for 
bullet design, at the bottom of the menu 
click Define New Bullet. 

2. On the Bullets menu, click to choose a bullet style. 

When you click a bullet to apply that style to the paragraph, a couple of things 
happen. Word adds the bullet and automatically formats the paragraph with a 
hanging indent so that the first line of the paragraph extends farther to the left 
than the other lines. The bullet appears in this overhang, calling attention to the 
bullet and setting off the paragraph from the other body text. 
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3. Type some text, and then press Enter to start a new paragraph. 

When you hit Enter to create a new paragraph, Word assumes that you're 
continuing with your bulleted list, so it adds the same bullet and indent 
automatically. You don't have to do anything; just keep on writing. 

4. When you're through with your bulleted list, press Enter, and then click the  
Home  Paragraph  Bullet button again to turn off bullet formatting. 

The paragraph with the insertion point changes from a bulleted paragraph to a 
normal paragraph. 

If you have a few paragraphs that you've already written, and you want to change them 
to bulleted paragraphs, just select all the paragraphs, and then click the Bullet button. 

 

 

Numbered paragraphs 

In most cases, numbered paragraphs work just like 
bulleted paragraphs. You can follow the step-by-step 
instructions in the previous section for making bulleted 
paragraphs to make numbered paragraphs. Just click 
the Numbering button, and then choose a number style. 

The main distinction between the numbered paragraphs 
and the bulleted paragraphs is in the options. For 
numbered paragraphs, you can choose from Arabic 
numbers, Roman numerals, numbers set off by 
parentheses, and alphabetic sequences. You can even 
use words such as One, Two, Three, or First, Second, 
Third. 
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Format Painter 

Whether it's a special heading or a paragraph of text, formatting a paragraph just the 
way you want it is a lot of work. Once you have the margins, indents, and tabs in place, 
and you've got the font style and size set, you've invested a chunk of time in the project. 
Fortunately, you can capitalize on that investment. The Format Painter works like 
magic. You can use it to copy the formatting of a word, heading, or paragraph onto 
something else. You don't have to worry about any of the formatting details. You don't 
even need to know how something is formatted, so long as you like the way it looks. 

 

Here's how it works: 

1. Select the character or paragraph with the formatting that you want to copy. 

You can copy and paint either the character or the paragraph formatting. If you 
want to copy just text formatting (font, size, text color, and so on), select a few 
letters or a word with that formatting, not the whole paragraph. Selecting an 
entire paragraph, complete with the paragraph mark at the end, copies both the 
character formatting and the paragraph formatting. If you don't select anything, 
the Format Painter uses the formatting from the current paragraph, so to copy 
paragraph formatting alone (for example, tabs and indents), just click anywhere 
in the paragraph. 

2. Go to Home  Clipboard and click the Format Painter button. 

Your cursor acquires a tiny paintbrush icon. If you have only one quick change to 
make, just click the Format Painter once. However, if you want to copy the same 
formatting to several different locations, double-click the Format Painter. When 
you double-click, the button stays locked down, indicating that it will stay on and 
let you paint multiple times until you're ready to stop. 

3. Drag the Format Painter over the text or paragraph that you want to change. 

Here's the fun part. Like magic, your selection takes on all the formatting that you 
copied. If you double-clicked for multiple format painting, you can keep on 
dragging over text or clicking paragraphs. When you're through, hit Esc. The 
Format Painter button pops back up, and your cursor changes back to its normal 
I-beam appearance. 
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Spell Checking 

Word's spell checker reads every word in your document and looks it up in its behind-
the-scenes dictionary file. If the word isn't in the dictionary, the spell checker flags it as a 
possibly misspelled word. Spell checker handles misspelled words in three ways: 

• AutoCorrect. The spell checker looks to see if the word is in its list of words to 
correct automatically. Words like "hte" for "the" or "shwo" for "show," for example, 
are in the AutoCorrect list. (You can add and remove words from the AutoCorrect 
list, and if you prefer, you can turn off AutoCorrect entirely 

• Check spelling as you type. If you've set up Word to check spelling errors as 
you type, the spell checker puts a wavy red line under the word in question. 

• Check spelling manually. Check spelling in one pass. The spell checker asks 
you about each questionable word when you run a manual spell check. 
 

Checking Spelling As You Type 

Unless you've turned this option off, as described in the previous steps, Word checks 
the spelling of each word you type, comparing it to its spelling dictionary. When a word 
is not in the dictionary, the spell checker brings it to your attention with a wavy red 
underline.  

 

 

 

 

To correct a word flagged with a wavy red line, 
right-click it. A shortcut menu shows suggested 
spellings for the word you flubbed. To choose a 
word from the list, just click it, and the correctly 
spelled word replaces the misspelled word. 
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Sometimes the spell checker flags a word, but you want to keep it in your document just 
the way it is (and make Word stop underlining it). For these words, the shortcut menu 
gives you three courses of action: 

• Ignore. Click Ignore, and the spell checker ignores this instance of the word (in 
this document only) and removes the underline. 

• Ignore All. When you choose this option, the spell checker doesn't flag any 
occurrence of the word in this document. 

• Add to Dictionary. When you add a word to the dictionary, you'll never see a 
wavy line under the word again, in this document or any other. Word adds the 
word to its custom dictionary. Over time, your custom dictionary collects all the 
special words that you don't want flagged in a spell check. 

Checking Spelling Manually 

When you opt for manual spelling and grammar checking, you can do these tasks in 
one pass, at your leisure, like after you've finished writing. To start a spelling and 
grammar check, choose Review  Proofing  Spelling and Grammar; or F7. 

 

 
 
 
 
 
 
 
 
 
 
 
When you use the manual spell checker, you work in this dialog box. The top text box 
shows you your word in context. The bottom text box offers suggested spellings. 

On the right side of the dialog box, you see several buttons. Use one of the top three 
buttons: Ignore Once, Ignore All, and Add to Dictionary when you want to keep the 
word spelled as it is. These options do the same thing as the shortcut menu options. 

The bottom three buttons let you make changes to the misspelled words. When you 
select a word from the Suggestions list, and then click Change, Word replaces the 
highlighted word with the suggestion. When you click Change All, Word looks through 
your whole document, and corrects any other occurrences of the misspelled words at 
the same time. Clicking the AutoCorrect button tells Word to make the correction 
automatically, as you type, every time you misspell the word. 
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Grammar and Style Checking 

Word's grammar and style tools work almost exactly like the spelling tools. You have the 
same choice between background checking and manual checking. If you check 
grammar and style in the background while you type, word puts a wavy green line under 
suspect sentences and phrases. If you check grammar manually, you view problem 
sentences in the Spelling and Grammar dialog box. 

 

 

 

 

 

 

 

Text in the upper-left corner describes the error, and suggestions appear at bottom. For 
a more detailed description of the problem, click Explain. 

 

You may feel that Word's grammar police are a little too strict for your personal style of 
writing. If that's the case, you can tinker with the settings (Office button  Word Options 

 Proofing). Here are some of the options you toggle on or off in the Grammar Settings 
box: 

• Capitalization. Finds words that should be capitalized, (like madame DeFarge). 

• Fragments and run-ons. Checks for complete sentences and flags overly long 
meandering sentences that seem to just go on and on and you can't wait for 
them to stop but they never do. 

• Misused words. Looks for the incorrect use of adjectives and adverbs. 

• Negation. Flags double negatives. 

• Noun phrases. Checks for proper usage of "a" and "an" and finds phrases 
where the number doesn't agree with the noun. For example, it wouldn't like "A 
Tale of Two City." 
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• Possessives and plurals. Leave this option checked if you have a problem 
forgetting apostrophes in phrases like "the ships hold." 

• Punctuation. Checks your usage of quotation marks, commas, colons, and all 
those other little marks. 

• Questions. Checks for question marks, and flags questions with non-standard 
structure. 

• Relative clauses. Finds errors in relative clauses, such as the use of "which" 
instead of "who" in a clause referring to people. 

• Subject-verb agreement. Flags sentences where the verbs don't match the 
nouns, as in "All of the nobles has gone to the guillotine." 

• Verb phrases. Finds errors in verb usages such as incorrect tense. 

 

Print Preview 

You find Print Preview with a couple of other print commands on the Office menu. To 
see them, go to Office button  Print. 

 

 

 

 

 

 

 

 

 

You see three print options: Print, Quick Print, and Print Preview. The Print option 
opens the Print dialog box (just like pressing Ctrl+P). The Quick Print option does the 
same thing as clicking the Print button on the Quick Access toolbar: It prints one copy 
no muss, no fuss, no options. The Print Preview button shows you how your document 
will look on the printed page. 
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The whole purpose of Print Preview is to show you your document exactly the way it will 
look on the printed page. Word's Print Layout does a pretty good job of that when you're 
writing and editing, but Print Preview is more accurate. Headers and footers are 
positioned precisely, and they're not grayed out. Non-printing characters like tabs and 
paragraph marks don't show up in Print Preview. And if you're using facing pages, Print 
Preview gives you a good feel for the end result. Print Preview's a great place to check 
to see if your margins are wide enough and to catch widows and orphans and 
abandoned headers at the bottom of the page. 

 

What's more, if you find something wrong, Print Preview puts all the tools you need for a 
quick fix right there on the ribbon. You can resolve a lot of last-minute problems with the 
Page Setup tools on the ribbon.  

 

 

 

 

 

 

 

 

 

Questions or Problems?  

Contact the Technology Assistance Center (TAC)  
Location: Hoggard Hall, room 126 
Phone: 962-HELP (4357)  
E-mail: tac@uncw.edu.  
Normal hours of operation: 
Monday – Thursday, 7:30am-11pm; Friday, 7:30am-5:30pm; Sunday, 12pm-11pm 


